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Additional Resources
In addition to these Release Notes and HTML Help, Tecplot
360 includes access to these manuals (and an online forum) to
help you explore all of Tecplot 360’s functionality.
• Getting Started Manual Your introduction to Tecplot
360 EX includes a tutorial that will help you learn your
way around the product.
• User’s Manual This manual provides a complete
description of working with Tecplot 360 EX features.
• Scripting Guide This guide provides macro command
syntax and information on working with macro files
and commands.
• Quick Reference Guide This guide provides syntax for
zone header files, macro variables, keyboard shortcuts,
and more.
• Data Format Guide This guide provides information
on outputting simulator data to Tecplot file format.
• Installation Guide These instructions give a detailed
description of how to install Tecplot 360 on your
machine.
My Tecplot
My Tecplot is Tecplot’s one-stop portal that allows you to
download software, manage your license keys, and more.
Visit it at https://my.tecplot.com/.
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Welcome to Tecplot 360 EX 2017 R2
Tecplot 360 EX 2017 R2 continues our commitment to
improving the power, performance, usability, and reliability
of our industry-leading flagship data visualization product.
While it’s only been a few months since our last release, we
think you’ll be pleased with what we’ve been able to do in
such a short time.
What’s New In Tecplot 360 EX 2017 R2
PyTecplot 0.8.0

When introduced as part of Tecplot 360 EX 2017 R1,
PyTecplot provided access to many frequently-used
capabilites of Tecplot 360 EX, but not all. PyTecplot 0.8.0 is
much closer to complete. If you need a capability that
PyTecplot does not currently provide, please let us know at
support@tecplot.com to help us prioritize upcoming work.
New API coverage in PyTecplot 0.8.0 includes:
• Interpolate
• 2D and 3D vectors
• Streamlines
• View adjustments
• Contour and line legends
• 3D orientation axis
• Auxiliary data
• Node map, face map, and face neighbor information
• Solution time for transient data
• Slice extraction
The new included tec360-config script returns the paths
required for setting LD_LIBRARY_PATH on Linux, simplifying the
configuration of PyTecplot on Linux.
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We’ve made many updates to this frequently-used loader,
including:
• Significantly improved performance and reduced
memory requirements for data with shared grids
(typically time-dependent solutions).
In our test using a transient solution with 30 time
steps of about 1 million data points each, time to
first image fell from just over 74 seconds to under
4 seconds (a reduction of 95%), and memory use
was cut by more than 90% (both compared to
Tecplot 360 EX 2017 R1). Your results may vary.

• FLUENT Additional Quantities can now be loaded
• Variables in symmetry zones can now be loaded
• Variables that were previously imported as
Variable#1234 are now given proper names
• Increased responsiveness and progress feedback while
reading FLUENT data
Other Improvements

• Q Criterion Calculation
The Calculate Variables function (on the Analyze
menu) can now calculate Q Criterion—faster and more
memory-efficient than using macros or equations to
calculate the quantity.
In our test using a Plot3D data set with 5,800
zones and 263 million cells, calculating Q Criterion
using Calculate Variables was more than six times
faster than a macro we provide for the calculation
(from nearly 47 minutes to 7 minutes and 20
seconds). Using a .szplt file further reduced the
time required by 22%. Your results may vary.
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What’s New In Tecplot 360 EX 2017 R2

FLUENT Loader Improvements
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• Extract Precise Line
The Extract Precise Line function has returned. It’s now
in the Extract submenu of the Data menu, rather than
on the Tools menu.
• Axial Rotation and Duplication
2D and 3D grids can be rotated, and zones may be
duplicated by repeatedly rotating them around an axis.
This feature is commonly used in turbomachinery
applications (for example, to duplicate blade rows). A
2D version of the rotation feature was in the legacy
(non-EX) version of Tecplot 360.
• Easier Frame Deletion
It’s now possible to delete the active frame using the
Frame menu, or the frame’s right-click context menu in
the work area or the Frames sidebar.
• Improved Font Support
Greek text is rendered better, and the bold and italic
tags in text objects now work with system fonts.
• Choose Surface Generation Method
When creating slices or iso-surfaces, you can now
choose from two surface generation methods, to
achieve smoother contours or to avoid holes in the
surface. Look for this setting in the Other page of the
Slice Details dialog and in the Style page of the IsoSurface Details dialog.
• Improved Animation Controls
All animation features now use VCR-style controls.
Previously, only some animation dialogs had them.
• Easier License Installation
The Licensing dialog now accepts a pasted single-user
license key.
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In Tecplot Chorus, the Group By feature in line plots
has been replaced with the ability to use variables to
define line color and symbol shapes, providing two
levels of line groupings to help you better understand
the trends in your data.
Tecplot SZL Server Improvements

Our lightweight server for remote data access now:
• Much better performance with data sets with large
numbers of zones
In our test involving a 681-million-cell simulation
with 81 time steps accessed from Tecplot SZL
Server over a SSH-tunneled connection, the time
needed to open the file and display all time steps
in sequence was cut in half, from 1737 seconds to
834 (compared to Tecplot 360 EX 2017 R1). Your
results may vary.

• Supports two-factor authentication and password
authentication for SSH connections
• Remembers the last-used directory
• Can load files from multiple directories
TecIO Improvements

The TecIO library, provided to allow third-party applications
to write Tecplot-format .plt and .szplt data files (and read
.szplt files), now includes an easier-to-use API for writing
SZL files. The new API supports 64-bit indexing, allowing
individual zones to exceed two billion nodes. This API is also
more flexible in the order in which it accepts data. Finally, the
new API can write all supported Tecplot data types except
bits, including integers of 8, 16, and 32 bits, instead of just 32bit and 64-bit floating-point numbers.
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What’s New In Tecplot 360 EX 2017 R2

• Incorporates Tecplot Chorus 2017 R2
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Bug Fixes

The following bugs are fixed in this release.
• Sporadic Mac hang when double-clicking buttons
• Corruption of auxiliary data when using Plot3D loader
• Contour levels would always reset to a single value
after encountering a variable with a constant value
• Image export would fail on Windows when using
Remote Desktop to a remote machine with an older (c.
2008) graphics card that does not support PBuffers
• Various clipping issues when exporting EPS files
• Data files with only custom labels or geometries could
not be loaded (introduced in Tecplot 360 2017 R1)
• Some Star-CCM+ and FLUENT files would not load
properly using the CGNS loader
• Could not load EnSight .case files with trailing spaces
• CFD analysis did not always use calculate on demand
• Axis% text size option was sometimes unavailable
• Crash with Probe to Create Time Series macro
• Layouts were not being saved correctly after toggling
off Time Stands in the strand editor
• Solution time grid marker was not updating when
stepping through time steps
• Several issues using calculated variables with SZL data
• Inefficient lookup of SZL variable values from macros
• Crash plotting surfaces of volume data using transient
SZL data
• Crash in primary value contour flooding using a cell
centered variable that is different than the cell centered
variable used to define the iso-surface (SZL data)
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What Was New In Tecplot 360 EX 2017 R1

Platform Changes

Mac OS X 10.9 is no longer a supported platform. Mac OS X
10.10 or later is now required.
What Was New In Tecplot 360 EX 2017 R1
If you missed our massive early-2017 release, the features
below are new to you!
• TecPLUS Replaces SMS, Brings New Features
TecPLUS (which replaces the Software Maintenance
Service) not only gives you all the benefits of SMS, it
also provides you with the ability to use Tecplot
Chorus, PyTecplot, and Tecplot SZL Server while your
subscription is active. (New licenses include a year of
TecPLUS.) For details, see TecPLUS Subscriptions.
• Variable Combining
Variable combining (available in pre-EX Tecplot 360)
has returned in an even easier-to-use form.
When loading multiple files in supported formats,
you’ll have the opportunity to tell Tecplot 360 EX
which, if any, of the variables in these files have the
same meaning by combining them.
Besides a new dialog that lets you combine variables
interactively, you can create a variable alias file and
combine pre-defined variables with a single click.
• Set Slice Orientation By Selecting Three Points
You can set the orientation of a slice either by entering
the coordinates of three points on the desired cutting
plane or by interactively probing the three points.
• New Algorithm for Iso-surface Generation
The MC33 algorithm is now used for deriving isosurfaces, providing better visual results and improved
performance.
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• Batch SZL Conversion
Tecplot 360 EX can now be used to easily batch-convert
your data files to SZL format (.szplt) for improved
interactive performance. This capability does not
require a license, so you can use it on, for example, a
compute cluster without using Tecplot 360 EX network
seats.
See Section 27-5 in the User’s Manual for an in-depth
discussion of batch conversion.
• TecIO Can Now Read SZL Files
The TecIO library, which has long had the ability to
write both Tecplot binary (.plt) and SZL (.szplt) files,
now has the ability to read SZL files. See the Data
Format Guide for more information.
• New Transient Tutorial in Getting Started Guide
The Tecplot 360 EX Getting Started Guide now includes
a transient data tutorial involving a vertical-axis wind
turbine model with 127 time steps.
• Incorporates Tecplot Chorus 2017 R1
Tecplot Chorus 2017 R1 has movable columns in table
views; loader descriptions for EnSight, OpenFOAM,
and TRIX data files; and support for non-standard
Tecplot-format filename extensions (.dat and .tec) used
by some solvers.
For more information on these new features, see the
Tecplot Chorus release notes.
In addition to these all-new features, Tecplot 360 EX 2017 R1
included numerous improvements to data loading:
• There is now a loader for the TRIX file format (an XMLbased unstructured file format used by Cart3D and
related solvers)
• The CGNS loader now supports CGNS formats up to
version 3.3. CGNS Cases containing polyhedral
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(NGON/NFACE) data and non-uniform meshes can
now be loaded.
• The PLOT3D loader now supports continuation
markers, allowing very large data sets to be loaded.
• The FLOW-3D loader now supports v11.1.2.7 files.
• The FEA loader can now load von Mises stress data
from NASTRAN files. It also now correctly loads
NASTRAN files containing both cell-centered and
nodal variables.
Note that this latter change may cause layouts or
macros to refer to the wrong variables; a warning
appears when you load such files. To address the
warning, re-create the layout or macro, or else update
the style settings as necessary and change the
!$READDATASET instruction in the layout or macro to
include the parameter "FEALoaderVersion" "436".
• Better support for loading data and other files from
Unicode file system paths. Also, all text files supported
by Tecplot 360 EX (including style sheets, variable alias
files, layouts, macros, and ASCII data files) can now be
read even if they include a Unicode byte order marker.
• All loaders can now open files directly from the Load
Data dialog, and all have the ability to append data to
your existing layout. Loaders without these capabilities
(which included EnSight, Excel, HDF, and HDF5) have
been upgraded to have them.
• A few data loading bugs have been fixed. The CGNS
loader now reads 64-bit integers properly, allowing files
written using a 64-bit version of the CGNS library to
loaded. And Tecplot 360 EX no longer crashes when
loading a nonexistent recent file from the Welcome
Screen.
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TecPLUS Subscriptions
As of January 1, 2017, TecPLUS replaces Tecplot’s Software
Maintenance Service (SMS). With TecPLUS, you get all the
benefits of SMS, including:
• No-charge upgrades to Tecplot 360 EX during your
subscription period
• Unlimited technical support
• One free hour of online training per year
Additionally, an active TecPLUS subscription gives you
access to the following components, boosting your Tecplot
360 EX license to a whole new level of value:
• Tecplot Chorus
Our simulation analytics product for engineers who
work with large numbers of cases. Previously, Chorus
included Tecplot 360 EX to view individual cases’ data
files; we’ve flipped that, and now offer every Tecplot
360 EX user access to this powerful tool.
• PyTecplot
Tecplot and the Python programming language
reunite! PyTecplot works with your system’s installed
Python and with popular Python tools like NumPy,
SciPy, and Jupyter. PyTecplot features an easy-to-use
object-oriented approach to working with your data
and plots using the engine that powers Tecplot 360 EX.
• Tecplot SZL Server
When your data is too big to move around comfortably,
you can install this lightweight server on most Linux
hosts to quickly and securely access your remote data.
Your basic Tecplot 360 EX license is perpetual: even if your
TecPLUS subscription expires, you will still be licensed to
run any version of Tecplot 360 EX released while your
1
subscription was active—forever. However, your access to
these additional software components (Tecplot Chorus,
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Most Tecplot 360 EX users now receive a new license key
annually, even those without TecPLUS. If you currently have
a Tecplot 360 EX license with active SMS, you can receive a
new license key that activates the TecPLUS features through
My Tecplot or by contacting sales@tecplot.com.
Usage Data Collection
To help us better understand how our customers use our
products and improve them further, Tecplot 360 EX includes
an analytics feature that reports user activity over the
Internet using the Google Analytics™ platform. This feature
tells us which dialogs you use and which controls you
manipulate in them. However, to protect your privacy and
trade secrets, we do not see names associated with your data
(such as variable, zone, or file names) or the actual values of
fields in dialogs, nor do we receive any information about
you or your organization’s identity.
If you do not wish to participate in this program, turn off
“Collect Anonymous Usage Data” in the Help menu.
We receive basic information about your operating system,
product version, and license at each launch of Tecplot 360 EX,
even if you have opted out of the usage data program. This
information is not tied to any usage data collected.
No usage data of any kind is collected if you do not have
access to the Internet or if the Google Analytics service is
blocked by a firewall.

1. While your license is perpetual, we cannot guarantee compatibility of today’s Tecplot products with future systems.

13

Usage Data Collection

PyTecplot, and Tecplot SZL Server) ends when your TecPLUS
subscription expires.
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Key Features of Tecplot 360 EX
Are you making the leap from Tecplot 360 to Tecplot 360 EX?
Here’s what you have in store.
Launched in 2014 after more than two years of effort, Tecplot
360 EX is a substantial upgrade to previous versions of the
product, with improved performance and ease of use
compared to Tecplot 360 2013 and earlier.
High Performance With Large Data Sets

Tecplot 360 EX 2014’s subzone data format (SZL—say
“sizzle”) reduces the amount of data that needs to be loaded
for common operations, providing much better performance
and lower memory usage for typical workflows on large data
sets, especially over networks. These advantages require that
data files be stored in SZL format (filename extension .szplt).
Native Look and Feel

The user interface has been revamped using a modern UI
framework (Qt) to provide a native look and feel for all
supported platforms. Linux and Mac OS X users in particular
should be pleased with this change, though Windows users
will also see benefits.
The high points include:
• Dockable sidebars that can be attached in flexible ways
to the main workspace, or even be positioned outside
the workspace (e.g. on another screen)
• Right-click context menus and pop-up toolbars
• A more flexible toolbar with redesigned icons
• Sidebars for managing frames, pages, and macros and
viewing probe results
• Redesigned Zone Style, Mapping Style, and Load Data
dialogs, and smaller improvements to many others
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Finding Familiar Features
Some commonly-used features are now available in a more
convenient way than in Tecplot 360 2013 and earlier. For
example, instead of using options on the Frame menu to
change the order of frames, the new Frames sidebar provides
this functionality (you can also right-click the frame border).
Similarly, page management, which once required running
macros provided in the Quick Macro Panel, can now be
performed in the Pages sidebar.
The Paper Setup dialog, formerly found in the Options
menu, is now in the File menu.
To copy an image of the plot to the clipboard for pasting into
another application, simply select the frame using the mouse
and choose Copy from the Edit menu. There is no separate
Copy Plot to Clipboard menu command.
Many features can now be found in the context menu. Rightclicking almost any object in the Tecplot 360 workspace gives
you quick access to commonly-used settings and actions that
apply to that kind of object. These functions are not always
available in other ways. For example, the Write Curve Points
to File option, which used to be available through the Curve
Information dialog found on the Data menu, is now accessed
by right-clicking the actual curve in the workspace. Context
toolbars are available for many situations, largely replacing
the Quick Edit dialog.
Omitted Features
For most users, the Tecplot 360 EX feature set approaches
parity with the last legacy (non-EX) release of Tecplot 360,
Tecplot 360 2013. Most of the remaining omitted features are
used infrequently, if at all, by the vast majority of customers.
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• On Mac OS X, an X window server is no longer
required to run Tecplot 360 EX since it is now a native
Mac application

Welcome to Tecplot 360 EX 2017 R2

Most omitted features are supported via the Tecplot macro
language, even if there is no user interface for the feature.
Tecplot 360 EX fully supports loading layouts and macros
that use these features. Therefore, a possible workaround for
workflows that rely on an omitted feature is to record the
operation in Tecplot 360 2013 R1 (or any older version) as a
macro and play it back in Tecplot 360 EX, or to write the
macro from scratch. You can add these macros to the Quick
Macro panel for easy access.
Other omitted features include:
• Coordinate transform and shifting of pseudo-cellcentered data
• Depth blanking
• Surface clipping using slices
• The Quick Edit dialog (it won’t be returning; see the
new right-click context menus and toolbars)
• Image export in X3D, Sun Raster (RAS) and X-Window
Bitmap (XBM) formats
• Animation export in Flash Video (FLV) format (SWF
remains supported)
• Creation of HTML files for Web publication
• The add-ons Circle Stream, Code Generator, Compare
XY Maps, Create Finite Element Sub-Zone, Distribution
Plots, Export DXF, Extrude, Prism Grid, Sort, Statistics
Calculator, Tecplot GUI Builder, Tetra Grid, and View
Binary
• Curve-fitting add-ons (“extended curve fit”) and
power fit options
• Some options for changing the view and arranging the
draw order of on-screen objects, though the same
results can be obtained using available features
• The Group Select, Select All, Polar Drawing Options,
Reference Scatter Symbol, and Print Preview dialogs
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• The Constraint page of the Slice Details dialog, which
allows a slice to be constrained by a bounding box
• Creation of 1-D line zones and zone creation by
entering values
Third-party add-ons built for use with Tecplot 360 2013 or
earlier are not compatible with Tecplot 360 EX. We intend to
release an ADK (Add-On Developer’s Kit), although we are
unable to commit to a specific release date at this time. To
request early access to add-on migration information, contact
support@tecplot.com.
Macro Compatibility Note
Macros and layouts created with previous versions of Tecplot
360 that create calculate-on-demand variables may not
operate correctly in Tecplot 360 EX due to a change to the
default value for the Connect Adjacent Zones setting in the
Geometry and Boundaries dialog (on the Analyze menu).
This can be corrected by re-recording the macro in Tecplot
360 EX or by editing the SetGeometryAndBoundaries command
in the macro or layout to explicitly specify ConnectZones
rather than relying on the default value:
$!EXTENDEDCOMMAND
COMMANDPROCESSORID = 'CFDAnalyzer4'
COMMAND = 'SetGeometryAndBoundaries
Axisymmetric=\'F\' SymmetryVar=\'Y\'
SymmetryValue=0 ConnectZones=\'F\'
NodeTolerance=1e-006 DefaultBC=\'Extrapolated\''

Remote Display
Tecplot 360 EX with active TecPLUS subscription now
supports the Tecplot SZL Server, a lightweight Linux server
component that lets you access your data more easily from
remote servers. If you are currently using remote display to
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• The Journal and Sharing pages of the Data Set
Information dialog
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access remote data, you may find Tecplot SZL Server to be
the better solution.
Linux systems can use X Windows to display Tecplot 360 on
a separate system from the one on which Tecplot 360 is
actually running. Your X display software must support the
GLX OpenGL Extensions, or you must have the graphics
rendered by the host CPU using the Mesa software renderer
(tec360 -mesa).
Remote users may find performance better using remote
desktop software instead of X. In our tests, the HP Remote
Graphics Software was generally the most performant such
solution for Linux.
On Windows systems, you can use the included Remote
Desktop Connection utility, which transmits the entire user
interface to a remote computer. This allows the rendering to
be performed in hardware on the host computer and the
results transmitted across the network. On server versions of
Windows, more than one simultaneous session of this type
can be supported. ThinAnywhere is a plug-in that can
improve the remote performance of 3D applications over
slow networks.
On Mac OS X, use the Screen Sharing feature, which can be
enabled in the Sharing control panel (or a third-party
equivalent such as Vine Server, which may provide better
performance in some situations), and a VNC client, such as
Chicken of the VNC. This supports a single user at a time.
Remote desktop software is generally not suitable for
situations in which multiple remote users need to run GUI
applications such as Tecplot 360 EX on the host system at the
same time. In these situations, X on Linux is generally the
preferred solution (though the clients can be other
platforms).
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Please help us make Tecplot 360 EX better by sending a crash
report to us in the event that the application terminates
unexpectedly.
On Windows, Tecplot 360 EX creates a crash dump file. You
will receive a message indicating that a crash dump file has
been created. Click Yes in this dialog to open the folder
where the file is created. You can then e-mail the most recent
.dmp file in this folder, along with a description of what you
were trying to do, to support@tecplot.com.
On other platforms, no crash dump file is created. However,
we urge you to send us a report anyway with as much detail
as you can remember.
If you have a moment and a desire to be extra helpful, please
re-open Tecplot 360 EX and choose Enable Diagnostic
Logging in the Help menu. Then redo the steps you took to
cause the crash. Tecplot 360 EX will record your actions as a
macro file. If you are able to reproduce the crash, send the
resulting .mcr file to us (along with the .dmp file if you use
Windows). On non-Windows platforms, you can find the
.mcr file in /usr/tmp/tecplot_$USER/tpa_diagnostics.
Crash dumps and diagnostic macros are stored in a
temporary folder and will be eventually be deleted by the
system. There is no need to delete them manually.
Graphics Drivers
For best results, please make sure that you are using the
latest graphics drivers compatible with your hardware and
operating system. These can be obtained from your graphics
adapter vendor’s Web site. Old versions may have issues
with Tecplot 360 EX, especially with larger data sets.
• NVIDIA: http://www.nvidia.com/Download/index.aspx
• ATI: http://support.amd.com/en-us/download
• Intel: https://downloadcenter.intel.com/Default.aspx
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Crash Reporting

Crash Reporting
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Platform-Specific Notes
The following table outlines the support for various
platform-specific features in Tecplot 360 EX 2017 R2.
Linux

Mac OS X

Windows

FLOW3D loader
ABAQUS loader
Excel Loader
Tecplot Chorus
Tecplot SZL Servera
a. The SZL Server runs only on Linux, but Tecplot
360 EX running on any supported platform can
connect to the server as a client

Refer to the remainder of this section for issues specific to
your operating system.
Windows

Your account must have administrator rights on your
computer to install Tecplot 360 EX, or else right-click the
installer and choose “Run as Administrator.”
Linux

• Ubuntu Linux
With Ubuntu’s new Unity UI, minimizing Tecplot 360
EX may cause its pull-down menus to become
unresponsive when the application is later restored. As
a workaround, you may choose “Ubuntu Classic” or
20

Tecplot 360 EX is supported only on LTS (Long Term
Support) releases of Ubuntu.
• Temporary Directory
Tecplot 360 EX relies on being able to create temporary
files in the system temporary directory. On Linux, this
directory is typically /usr/tmp or /var/tmp. If your user
account does not have permission to write into the
system temporary directory, you can use a different
directory either by setting the TMPDIR environment
variable in your profile or by setting the TEMPFILEPATH in
the tecplot.cfg file.
• Menu Shortcuts
Menu shortcut keys may not work if the NUM LOCK is
on. You may set the NUM LOCK to turn off
automatically at boot in your computer’s BIOS.
• SELinux
SELinux (provided with some Linux distributions)
adds an extra layer of security. If you see this error
message:
.//bin/tecplot.shared: error while loading
shared libraries: .//lib/libtec.so: cannot
restore segment prot after reloc:
Permission Denied
Enter these two commands, replacing /path/to/tec360/
lib with the actual path of your installed Tecplot 360 EX
lib directory (your account needs sudo permission):
sudo chcon -v -R -u system_u -r object_r -t
lib_t /path/to/tec360/lib/
sudo chcon -t texrel_shlib_t /path/to/
tec360/lib/*

You can then run Tecplot 360 EX without disabling
SELinux.
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“Ubuntu 2D” when logging in, or set your user account
to use one of these as the default in the Login Screen
control panel.
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• Remote Display Issues
If you have a Network license, you can run Tecplot 360
EX on one computer and display it on a second
computer (via an X server). The X server must support
GLX extensions, or else you must use the -mesa option
when launching Tecplot 360 EX to have all OpenGL
rendering performed in software on the host. Working
with large, complex files may benefit from the -mesa
option (see next bullet) even if your X server supports
GLX.
When displayed remotely, Tecplot 360 EX may exhibit
substantially lower drawing speeds than when it is
displayed locally, especially for text and geometries.
• Mesa Rendering
Mesa, an OpenGL-equivalent graphics library,
performs 3D rendering in software. It is typically used
when hardware acceleration is unavailable or when
working with remote display of large data.
The Mesa version of Tecplot 360 EX is slower, especially
for 3D plotting. If you must run the Mesa version and
display remotely, you can speed up the rendering for
XY Line and 2D plots by setting the environment
variable below. On some machines, this may also
improve the speed of 3D plotting that does not use
translucency. (Mesa translucency performance is
known to be very bad.)
export MESA_BACK_BUFFER=Pixmap
Mac OS X

• Keyboard Shortcuts
Previous versions of Tecplot 360 used the Control key
for most keyboard shortcuts, rather than the Mac
standard Command key. Tecplot 360 EX changes these
shortcuts to use the Command key under Mac OS X.
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Note that the Alt key may be called Option on some
Mac keyboards.
• Right Mouse Button
If your Mac’s mouse has only a single button, hold the
Control key while clicking to access right-click
functionality.
• Middle Mouse Button
There is no functionality in Tecplot 360 EX that requires
a middle mouse button; however, it does provide some
shortcuts. Users of single-button mice cannot emulate
the middle button, but users of mice with two buttons
can hold down Control while right-clicking if their
mouse does not support a true middle-button click.
• Remote Display
As Tecplot 360 EX uses the native Mac OS X user
interface on the Mac, you cannot access the application
on a remote workstation using an X window server.
Instead, use the Screen Sharing feature in the Sharing
control panel (or a third-party equivalent such as Vine
Server, which may provide better performance), and a
VNC client, such as Chicken of the VNC.
Since Tecplot 360 EX is not an X application under Mac
OS X, is not possible for multiple users to run Tecplot
360 EX on a Mac OS X host remotely.
Enjoy Tecplot 360 EX 2017 R2 and master the view!
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Platform-Specific Notes

Similarly, when rotating a 3D plot, you now hold down
the Command key while dragging with the right
mouse button.

